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Menus
Xantippe Menu Bar

File Menu
Edit Menu
Project Menu
HyperLink Menu
Style Menu
Window Menu
Help Menu



File Menu
File Menu Entries

New
Open...
Close
Save
Save As...
Insert...
Print Window
Print File Box
Print Project
Printer Setup...
Exit



New
New

This function will create a new project.



Open...
Open Project...

This function will open a project.

The user will be prompted with a dialog box to select the project file.



Close
Close Project

This function will close all windows associated with a project and unload the project from 
memory.



Save
Save

This function will save the currently active project.



Save As...
Save As...

This function will allow the user to save the currently active project to a different name, 
directory, or file format.

Xantippe currently supports two file formats, Xantippe native format and RTF WinHelp 
format.



Picture
Insert Picture...

This function is used to load a picture into a picture field.



Printer Setup...
Setup Printer



Print Window
Print a Window

Print the contents of the currently active window.



Print Project
Print Project

Print all the cards associated with the currently active project.



Print File Box
Print File Box Hierarchy

Print a file box and all the cards contained in the file box.



Exit
Exit the program

Terminate the program.



Edit Menu
Edit Menu Entries

Undo
Cut
Copy
Paste
Clear
Duplicate
Select All
Rename...
Keywords...
Empty Orphanage
Create Cards...



Project Menu
Project Menu Entries

Open Browser
Find Card
Renumber Card
Update Browser
Where Am I?
AutoUpdate Browser
Follow Me
Create SuperProject
Import Project
Export Project
Project List



HyperLink Menu
HyoerLink Menu Entries

Create
Examine
HyperJump
HyperLink Mode
HyperJump Link
HyperPopup Link



Style Menu
Style Menu Entries

Plain
Bold



Window Menu
Window Menu Entries

Open
Close
Circulate
Window List



Help Menu
Help Menu Entries

Index
Using Help
License
Contact
What is Xantippe?



Undo
Undo last action



Cut
Cut information to Clipboard

The function will cut the selected information to the clipboard.



Copy
Copy information to clipboard.

The function will copy the selected information to the clipboard.



Paste
Paste clipboard information into card.

This function will paste the selected information in the clipboard into the currently selected 
card.



Clear
Destroy information.

This function will destroy the currently selected information.    The selected information will 
not be placed in the clipboard.    The information will be lost forever.



Duplicate
Duplicate the selected information.

This function will duplicate the selected information.



Select All
Select all information.

This function will select all the information in a field.



Open
Open a window.

This function will open a window for the selected card.    This function only applies to the list 
field of a list card.

To use this function select a entry in the list field then invoke this function.    This function will
then open the card associated with the selected entry.



Close
Close currently active window.

This function will close the currently active window.



Rename...
Rename a card.

This function allows the user to rename a card.



Keywords...
Edit keywords for card.

This function will display a dialog box from which the user can edit the keywords associated 
with a card.



Empty Orphanage
Empty orphanage.

This function will destroy all the cards in the orphanage.

This function should be used with care since once the cards have been destroyed and the 
project saved there is no way to retrieve the destroyed cards.



Create Cards...
Create New Cards Menu Entries

File Box Card
Text Card
Picture Card



File Box Card
The file box card.

The file box card is a card in which other cards can be placed in.



Text Card
The text card.

The text card is a card in which textual information can be placed.    Chunks of the textual 
information can then be linked to other cards with hypertext links.



Picture Card
The picture card.

The picture card is a card in which graphical information can be placed.    Chunks or areas of 
the graphical information can then be linked to other cards with hyperarea links.



Open Browser
Open a browser

This function will open the browser associated with the currently active card.    If no cards are
currently active then Xantippe will open the browser for the first project in its internal list.



Find Card
Open a card by its id.

This function will prompt the user to enter the id number for a card.    The specified card will 
then be opened.    The id for a card can be found in its upper right hand corner.



Update Browser
Update the browser.

This function will update the browser associated with the currently active card.



Where Am I?
Move the browsesr to display the currently active card.

This function will reposition the browser so that the currently active card is viewable.



AutoUpdate Browser
Automatically Update the Browser

This is a check function.    When this function is active then Xantippe will automatically 
update the browser when a change is made to the network.



Follow Me
Currently active card is always visible in browser.

This is a check function.    When this function is active, the currently active card will always 
be viewable in the browser.



Create SuperProject
Create superproject.

This function will create a SuperProject from the currently loaded projects.



Import Project
Import project file.

Import a project file into the currently loaded super project.



Export Project
Export project

This function will export the    currently active project to a standalone project file.



Create
Create a hyperlink

This function will create a hyperlink.    A hyperlink is a link that connects a chunk of 
information in one card to another card.    A chunk of information can be a phrase in a text 
field or an area of a picture in a picture card.

To create a hyperlink select the area in the card that is to be linked and choose this function. 
The cursor will then change to a plus sign, directing you to choose the card the chunk of 
information should be linked to.    Click on the card to link the chunk of information to and 
Xantippe will create the link.

The Xantippe can create two types of links, jump links and pop-up links.    The type of link is 
selected from the HyperJump Link command and the HyperPopup Link command.



Examine
Examine an existing Hyperlink

This function can be used to examine an existing hyperlink.    Xantippe will display a dialog 
box showing where the hyperlink points to.

To invoke this function, select the chunk of information that is hyperlinked and choose this 
function.    Xantippe will then display the dialog box.



HyperJump
Open card linked to.

This function will open the card that the selected chunk of information is linked to.

To invoke this function, selected the chunk of information to hyperjump.    Then invoke this 
function and Xantippe will open the card that the chunk of inforamtion is linked to.



Window List
List of open windows.

This menu contains a list of all the currently open windows.    The type of card in each 
window can be distinguished by style of the text used to display the name.

The currently active window is indicated by a mark to the left of the menu entry.

To make a window in the list the active window, select the menu entry for that window.



HyperLink Mode
Toggle hyperlink mode

This is a check function.    When this function is active Xantippe is in hyperlink mode.    In this
mode the hyperlinks can be tested in a simulated run-time environment.

The pointer cursor will turn into a hand when the cursor is in a hyperlink field.    The user can 
then click on the hyperlink information and Xantippe will open the card that the hyperlink is 
linked to.



Plain
Change Text Style to Plain

This function will change the style of the currently selected text to plain.



Bold
Change Text Style to Bold

This function will change the style of the currently selected text to bold. 



Circulate
Circulate windows.

This function can be used to circulate through all the currently open windows.

The currently active window is pushed to the bottom of the window list and the next window 
is made active.



What is Xantippe?
Xantippe

The Information Structuring Workbench

Xantippe is a tool to structure knowledge or information into a non-linear format.    The 
information can take the form of text or graphics.    Xantippe allows the user to orgranize the 
information by catorgorizing the knowledge and connecting related chunks of information 
with hyperlinks.



Glossary
Definition of Xantippe Terms.

Card
Field
Jump Link
Popup Link
Project
RTF
Rich Text Format
SDK
Socrates
SuperProject
Xantippe



Credits
Who's who of Xantippe.

Xantippe is the result of a joint development project between Scaitech A/S of Denmark and 
Rodney S.K. Lai of the United States of America.

The following people have contributed to the development of Xantippe:

Technical Consulting:
        Per Husmann Rasmussen
        Hans-Ole Hovgaard Nielsen
        Annette Petersen
        Hanne Peitersen

Interaction Designer:
      Michael Malcolm Andersen

Software Engineer:
      Rodney Lai



Contact
Who to contact in case of emergency.

Xantippe is marketed and supported by IRIS Media Systems.

    IRIS Media Systems
    1684 Locust St., Suite 125
    Walnut Creek, CA 94596 USA
    Phone: +1 510 256 4673
    Fax: +1 510 256 6353
    CompuServe: 76547,706
    GEnie: RODNEY.LAI
    AmericaOnline: RodneyLai



Xantippe
1. 5th cen. B.C.; wife of Socrates; the prototype of the quarrelsome, nagging wife.
2. A Knowledge Structuring Workbench.



Socrates
Soc ra tes (Sak're tez')

1. 470?-399 B.C.; Athenian philosopher & teacher.
2. A computer expert system to assist social workers i.e. the Social Assistant.



Getting Started
In The Beginning...

Starting Xantippe
Creating a new project
The Main File Box Card
The Orphanage File Box Card
Create a new card



Creating a new project
How to create a new project.

To create a new project use the 'New project' option from the File Menu.    When a new 
project is created a default name is given to the new project and two cards are created in 
the project.

The two cards created in a new project are two file box cards.    One is the main file box card 
which has the name of the project and an orphanage file box card.



The Main File Box Card
The Main Card

The main file box card is a specialized file box card.

The main file box card has the name of the project and it is from this card that all other 
cards in the network branch out from.



The Orphanage File Box Card
The Orphanage

The Orphanage Card is a specialize file box card.    The Orphanage Card contains all the 
cards that have been cut off from the rest of the network.

A card is defined as cut off from the network if you cannot reach the card from the Main 
Card.

Cards in the orphanage cannot be cut and cards cannot be pasted into the orphanage.    
Cards can be copied from the orphanage and pasted in cards attached to the network.

Xantippe will automatically update the orphanage as cards are cut and pasted into and out 
of the network.



Create a new card
How to create cards

Creating cards
Creating cards in a file box
Creating cards in a text card



Creating cards in a file box
How to create a card in a file box.

When a new card is created in a file box the new card is displayed in the list field of the file 
box.

The new card is placed before the currently selected card in the list field.    If no card is 
selected in the list field then the new card is placed at the end of the list field.



Creating cards in a text card
How to create a new card in a text card.

Creating a new card in a text card is similar to creating a hyperlink.    New cards can only be 
created in a text field that has the hyperlink property.

To create the new card first select the text that is to be linked to the new card.    Once the 
text has been selected, create the new card.    Xantippe will then create the new card and 
link the selected text to the new card.    Xantippe will indicate that the text is linked to the 
new card by making the selected text italic and enclosing the text in pointy brackets, '' and 
''.



Creating cards
How to create a new card.

To create a new card use the 'Create Card...' sub menu of the Edit Menu.

From the Create Card... Menu select the card you would like to create.    The new card will be 
created and a link from the currently active card to the new card will be created.



Starting Xantippe
How to start Xantippe.

Xantippe can be started in several ways.

1) The Run... command in the File Menu of the Program Manager and File Manager can be 
used to start the program.

2) If Xantippe was been imported into the Program Manager then double clicking on the icon
will start the program.

3) From the File Manager, double clicking on the Xantippe entry will start the program.

When the program starts the user will be prompted to load a project.    If 'Cancel' is selected 
then.no project is loaded and a new project will be created.



SuperProject
SuperProject

A superproject is a multi-file project.



License
Product License Agreement

Copyright to this software is held by IRIS Media Systems, USA.    In consideration of your 
payment of the agreed purchase price and your agreement to these terms you are hereby 
licensed to use the software.

You must treat the software as if it were a book.    For example: you may loan the software to 
someone - but you must not retain a copy for your own use if you do so.    You must not allow
the software to be used by any other individual or company to the extent that IRIS Media 
Systems could be deprived of a further sale.    You agree not to copy the software except for 
the purpose of makeing a backup and protecting your investment.    You may not copy or 
reproduce the printed and electronic manuals in any form for any reason.

You may copy the software to a hard disk or to memeory for your own use.    Multiple coies of
the software must not be used by two or more persons without the written permission of IRIS
Media Systems in the form of a site or multi user license.    You may use the software on a 
network or multi user system provided that it is accesed by only on user at any one time.

IRIS Media Systems has chosen not to use copy protection on the diskettes in the package 
for your convenience.    Projects and files generated using this software may be distributed 
free of charge.    They may be used with the shareware version of the software.    The 
shareware version of the software may also be copied and distributed free of charge if the 
proper information notice is attached to the copy.    The shareware version of the software 
may not be distributed for a fee without the written permission of IRIS Media Systems.



Index
Open Help Index.

This function will open the Xantippe Help file and go to the main index card.



Using Help
How to use the Help Program.

This function will open the windows help file.    From this file you can get information on how 
to use the Windows Help Program.



Project List
List of loaded projects

This menu contains a list of all the currently loaded projects.

The currently active projects is indicated by a mark to the left side of the menu entry.

To open the browser associated with a project, select the menu entry for that project.



Cards
Card Types

List Card
Text Card
Picture Card



List Card
The List Card

A list card contains a list of links to other cards in the system.

The list card consists of two fields, a text field and a list field.    The text field is used to place 
a one line description of the list.    The list field is used to list a series of cards in the system.



Text Card
The Text Card

The text card is used to encapsulate textual information.

The text card consists of two text fields.    The first text field is a title field.    The second text 
field is the body of the textual information.    In the body of the text the user can place 
hyperlinks to other cards in the system to indicate a relation between the connected cards.



Picture Card
The Picture Card

The picture card is used to encapsulate graphical information.

The picture card consists of one big picture field.    A picture can be inserted into this field by 
using the 'Insert...' submenu of the 'File' Menu.



Card
Card

A card (or window) is a basic unit of information encapsulation in Xantippe.

A card can be a text card, list card, or picture card depending on the type of information the 
card is encapsulating.



Project
Project

A project is a group of cards.    Physically a project is a single file stored on a disk.



Fields
Text Field
List Field



Field
Field

A field is the primitive elements that are used to make up a card.

A field can contain be used to store text, graphics, or a list.



Text Field
Text Field

A text field is a field that can contain textual information.



List Field
The list field

A list field is a field in which a list of other cards in the system are placed.



Browser
The Browser

What is a browser?
Pop-up Menu
Browser Picture



What is a browser?
The Browser

The browser is a graphical representation of the information network.    From the browser 
window the user can see the relation between cards in the network.    Different line types will
indicate different link types.    Different name font styles will indicate different card types.



Pop-up Menu
Open
Zoom
Cut
Copy
Paste
Rename...
Keywords...
Create Cards...



Open
Open card

Open the window associated with the currently selected card in the browser.



Zoom
Zoom in on card.

This function will zoom the browser in on the currently selected card.    The browser will show
all the link entering and exiting the selected card.



WinHelp File
Creating a Windows 3.0 Help File

Step 1. Save As...
Step 2. Create HPJ File
Step 3. Compile



WinHelp Format
RTF WinHelp Format

RTF WinHelp Format is an RTF file that can be compiled into a Windows 3.0 help file using 
the SDK help compiler.



Rich Text Format
Rich Text Format

The Rich Text Format (RTF) is an ASCII interchange format for the transfer of wordprocessor 
data files from one wordprocessor to another.



RTF
RTF

RTF stands for Rich Text Format.



SDK
SDK

SDK stands for the Windows 3.0 Software Developement Kit.



Step 1. Save As...
Create RTF File

The first step is to save the Xantippe project as an RTF file.    To save a Xantippe file as an 
RTF WinHelp choose the Save As... option in the File Menu.    From the save as dialog choose 
'RTF WinHelp' as the format to save as.    Then save the project.    Xantippe will then save the 
project in RTF WinHelp format.

The bitmaps from picture cards will be saved in seperate BMP files.    The files will have 
names in the format:

      Xindex.BMP

index is the id number of the card.



Step 2. Create HPJ File
Help Project File

The SDK help compiler needs an *.HPJ file to compile the RTF file.    The HPJ file is a command
file that tells the help compiler how to create the help file.    Refer to the SDK tools manual 
for a more complete description of how to create an HPJ file.    A very basic HPJ file would 
consist of the following:

        [OPTIONS]
        INDEX=PROJECTNAME_256

        [FILES]
        PROJECTNAME1.RTF
        PROJECTNAME2.RTF
            .
            .
            .
        PROJECTNAMEn.RTF

        [BITMAPS]
        XID1.BMP
        XID2.BMP
            .
            .
            .
        XIDn.BMP

PROJECTNAME is the name of the project.    ID is the id number of picture card that 
contained the bitmap.    INDEX is used to indicate the first card in the project.



Step 3. Compile
Compile the files

The last step is to use the SDK help compiler to compile the files.    Refer to the SDK tools 
manual on help to use the help compiler.



Browser Picture

 



Insert...
Insert Menu Entries

Text
Picture



Text
Insert Text...

This function is used to text from a data file into a text card.



Renumber Card
Change the id of a card

This function allows the user to change the internal id of a card.    The id of a card can be any
integer less than 65535.    Every card has a unique id.



HyperPopup Link
Link Type: Pop-up Link

Selecting this option will instruct Xantippe to create pop-up links when using the 'Create' 
HyperLink command.



HyperJump Link
Link Type: Jump Link

Selecting this option will instruct Xantippe to create jump links when using the 'Create' 
HyperLink command.



Popup Link
A pop up link in Windows help is invoked by holding the mouse button down over the popup 
hypertext.    The linked text is displayed in a box until the mouse button is released.



Jump Link
A jump link in Windows help 'jumps' the help system to the new text.




